<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>General</td>
<td>5</td>
</tr>
<tr>
<td>1.1 Copyright © VIPA GmbH</td>
<td>5</td>
</tr>
<tr>
<td>1.2 About this manual</td>
<td>6</td>
</tr>
<tr>
<td>Installation and activation</td>
<td>7</td>
</tr>
<tr>
<td>2.1 System requirements</td>
<td>7</td>
</tr>
<tr>
<td>2.2 Installing the SPEED7 EtherCAT Manager</td>
<td>7</td>
</tr>
<tr>
<td>2.3 Activating the SPEED7 EtherCAT Manager</td>
<td>8</td>
</tr>
<tr>
<td>2.4 Uninstalling the SPEED7 EtherCAT Manager</td>
<td>8</td>
</tr>
<tr>
<td>Deployment SPEED7 EtherCAT Manager</td>
<td>9</td>
</tr>
<tr>
<td>3.1 Overview</td>
<td>9</td>
</tr>
<tr>
<td>3.1.1 Main menu</td>
<td>11</td>
</tr>
<tr>
<td>3.2 ESI Manager</td>
<td>13</td>
</tr>
<tr>
<td>3.3 Automatic configuration of a slave system</td>
<td>14</td>
</tr>
<tr>
<td>3.4 Manual configuration of a slave system</td>
<td>15</td>
</tr>
<tr>
<td>3.5 Configuration - EC-Mastersystem</td>
<td>15</td>
</tr>
<tr>
<td>3.5.1 Preparation</td>
<td>15</td>
</tr>
<tr>
<td>3.5.2 Master</td>
<td>16</td>
</tr>
<tr>
<td>3.5.3 Process Data Image</td>
<td>17</td>
</tr>
<tr>
<td>3.5.4 Advanced Options (Expert mode)</td>
<td>17</td>
</tr>
<tr>
<td>3.5.5 Distributed Clocks (Expert mode)</td>
<td>20</td>
</tr>
<tr>
<td>3.5.6 I/O Address Overview</td>
<td>21</td>
</tr>
<tr>
<td>3.6 Configuration - slave station</td>
<td>22</td>
</tr>
<tr>
<td>3.6.1 Preparation</td>
<td>22</td>
</tr>
<tr>
<td>3.6.2 General</td>
<td>23</td>
</tr>
<tr>
<td>3.6.3 Modules</td>
<td>24</td>
</tr>
<tr>
<td>3.6.4 PDO Mapping</td>
<td>25</td>
</tr>
<tr>
<td>3.6.5 Advanced Options (Expert mode)</td>
<td>28</td>
</tr>
<tr>
<td>3.6.6 Ethernet (EoE)</td>
<td>31</td>
</tr>
<tr>
<td>3.6.7 Distributed Clocks (Expert mode)</td>
<td>32</td>
</tr>
<tr>
<td>3.6.8 Init Commands (Expert mode)</td>
<td>33</td>
</tr>
<tr>
<td>3.6.9 CoE Object Dictionary (Expert mode)</td>
<td>35</td>
</tr>
<tr>
<td>3.6.10 Process Image</td>
<td>36</td>
</tr>
<tr>
<td>3.6.11 I/O Address Overview</td>
<td>36</td>
</tr>
<tr>
<td>3.7 Configuration - modules</td>
<td>37</td>
</tr>
<tr>
<td>3.7.1 Please note</td>
<td>37</td>
</tr>
<tr>
<td>3.7.2 Preparation</td>
<td>37</td>
</tr>
<tr>
<td>3.7.3 MDP Slot Properties</td>
<td>37</td>
</tr>
<tr>
<td>3.7.4 Process Image</td>
<td>38</td>
</tr>
<tr>
<td>3.7.5 I/O Address Overview</td>
<td>38</td>
</tr>
<tr>
<td>3.8 Diagnostics - EC-Mastersystem</td>
<td>39</td>
</tr>
<tr>
<td>3.8.1 Preparation</td>
<td>39</td>
</tr>
<tr>
<td>3.8.2 General</td>
<td>39</td>
</tr>
<tr>
<td>3.8.3 CoE Object Dictionary</td>
<td>41</td>
</tr>
<tr>
<td>3.8.4 History (Expert mode)</td>
<td>41</td>
</tr>
<tr>
<td>3.9 Diagnostics - slave station</td>
<td>42</td>
</tr>
<tr>
<td>3.9.1 Preparation</td>
<td>42</td>
</tr>
<tr>
<td>3.9.2 General</td>
<td>42</td>
</tr>
</tbody>
</table>
3.9.3 ESC Register (Expert mode)....................................................................... 43
3.9.4 EEPROM (Expert mode)............................................................................. 44
3.9.5 Extended Diagnosis (Expert mode)............................................................. 44
3.9.6 DC Diagnosis (Expert mode)....................................................................... 45
3.9.7 CoE Object Dictionary................................................................................. 45
3.9.8 FoE Download/Upload................................................................................. 46
3.10 Grouping logic.............................................................................................. 47
3.10.1 Overview.................................................................................................... 47
3.10.2 Create group with pinned process data offset........................................... 49
3.10.3 Create Hot Connect group......................................................................... 50
3.11 EtherCAT State Machine.............................................................................. 52
3.12 Firmware update - VIPA System SLIO IM 053-1EC0x.................................. 53
1 General

1.1 Copyright © VIPA GmbH

This document contains proprietary information of VIPA and is not to be disclosed or used except in accordance with applicable agreements.

This material is protected by the copyright laws. It may not be reproduced, distributed, or altered in any fashion by any entity (either internal or external to VIPA), except in accordance with applicable agreements, contracts or licensing, without the express written consent of VIPA and the business management owner of the material.

For permission to reproduce or distribute, please contact: VIPA, Gesellschaft für Visualisierung und Prozessautomatisierung mbH Ohmstraße 4, D-91074 Herzogenaurach, Germany

Tel.: +49 9132 744 -0
Fax.: +49 9132 744-1864
EMail: info@vipa.de
http://www.vipa.com

Every effort has been made to ensure that the information contained in this document was complete and accurate at the time of publishing. Nevertheless, the authors retain the right to modify the information.

This customer document describes all the hardware units and functions known at the present time. Descriptions may be included for units which are not present at the customer site. The exact scope of delivery is described in the respective purchase contract.

EC Conformity Declaration

Hereby, VIPA GmbH declares that the products and systems are in compliance with the essential requirements and other relevant provisions. Conformity is indicated by the CE marking affixed to the product.

Conformity Information

For more information regarding CE marking and Declaration of Conformity (DoC), please contact your local VIPA customer service organization.

Trademarks

VIPA, SLIO, System 100V, System 200V, System 300V, System 300S, System 400V, System 500S and Commander Compact are registered trademarks of VIPA Gesellschaft für Visualisierung und Prozessautomatisierung mbH.

SPEED7 is a registered trademark of profichip GmbH.

SIMATIC, STEP, SINEC, TIA Portal, S7-300, S7-400 and S7-1500 are registered trademarks of Siemens AG.

Microsoft and Windows are registered trademarks of Microsoft Inc., USA.

Portable Document Format (PDF) and Postscript are registered trademarks of Adobe Systems, Inc.

All other trademarks, logos and service or product marks specified herein are owned by their respective companies.
1.2 About this manual

Objective and contents

This manual describes the SPEED7 EtherCAT Manager of VIPA:

- It contains a description of the structure, project implementation and usage in the Siemens SIMATIC Manager.
- The manual is targeted at users who have a background in automation technology.
- The manual is available in electronic form as PDF file. This requires Adobe Acrobat Reader.
- The manual consists of chapters. Every chapter provides a self-contained description of a specific topic.
- The following guides are available in the manual:
  - An overall table of contents at the beginning of the manual
  - References with pages numbers

Icons Headings

Important passages in the text are highlighted by following icons and headings:

- **DANGER!** Immediate or likely danger. Personal injury is possible.
- **CAUTION!** Damages to property is likely if these warnings are not heeded.
- *Supplementary information and useful tips.*
2 Installation and activation

2.1 System requirements

The minimum system requirements for installing the software package SPEED7 EtherCAT Manager are:

- Processor: Intel® Pentium® 4 or AMD Athlon® 64
- Operating system: Microsoft®, Windows 7®, Windows 8® or Windows 10®
- Working memory: At least 1 GB of RAM
- Hard disc space: 1 GB (no installation at portable flash memories possible)
- Monitor and graphics card: 1024 x 768 monitor resolution (1280 x 800 recommended) with OpenGL graphics card with hardware acceleration, 16-bit colour and 256MB of VRAM
- Software
  - Siemens SIMATIC Manager V5.5, SP2
  - PDF reader to read the supplied PDF files

2.2 Installing the SPEED7 EtherCAT Manager

You can install the SPEED7 EtherCAT Manager with a downloaded file.

 Execute the installation program:

- If you have downloaded the installer, double-click the downloaded file.
- Follow the instructions on the screen.

*The use of the SPEED7 EtherCAT Manager requires that you agree with the license agreement. During installation, you must confirm this.*

In addition to the SPEED7 EtherCAT Manager the following components are automatically installed, which are needed to run the software:

- Microsoft.NET Framework®
- WinPcap
2.3 Activating the **SPEED7 EtherCAT Manager**

30 days trial version

After installation you can use the **SPEED7 EtherCAT Manager** fully for 30 days as a trial version. After this time the software no longer runs and must be activated.

**Activation**

The activation happens with the following proceeding:

1. Start the **SPEED7 EtherCAT Manager**.
   - With each call of the **SPEED7 EtherCAT Manager** the remaining days are shown with the query if you want to activate an existing license.

2. To start the activation, confirm with [Yes].
   - The following dialog is opened:

3. Enter the serial number that you received with your order of **SPEED7 EtherCAT Manager** in the ‘Licence key’ input field.

4. Enter your name in the ‘Your name’ input field.

5. If you enter your e-mail address in the ‘E-mail address’ input field, you receive an e-mail confirmation regarding the product activation.

**Activate licence online**

- Click at [Activate].
  - The licence is activated and the **SPEED7 EtherCAT Manager** is started.

**Activate licence offline**

If the PC, on which you would like to use the **SPEED7 EtherCAT Manager**, is not connected to the Internet, you can activate the licence offline. For this, you need to obtain an activation key via another PC that is connected to the Internet.

1. Click at [Activate offline].
   - A dialog window with information on the subsequent steps opens.

2. Click at [OK] in the dialog window.
   - The ‘Save as’ dialog window opens.

3. Save the HTML file and transfer this file (e.g. with copy and paste) to a PC that is connected to the Internet.

4. Double-click at the HTML file.
   - The HTML page is opened in the browser. The activation key is accessed by the VIPA licence server and is shown in the browser.

5. Enter the activation key into the ‘Activation key’ input field in the ‘Product activation’ dialog window.

6. Click at [Offline activation] again.
   - The licence is activated and the **SPEED7 EtherCAT Manager** is started.

2.4 Uninstalling the **SPEED7 EtherCAT Manager**

You can uninstall the **SPEED7 EtherCAT Manager** in the control panel. A dialog is shown, where you can choose whether your stored projects remain or be deleted.
3 Deployment SPEED7 EtherCAT Manager

3.1 Overview

Properties
- Installation as TCI-Tool (Tool-Calling-Interface) within the Siemens SIMATIC Manager.
- Serves for configuration of a virtual PROFINET slave (Installation via GSDML).
- You can use multiple virtual PROFINET slaves to achieve the maximum possible number of I/O data. This segmentation is automatically recognized in the SPEED7 EtherCAT Manager. A virtual PROFINET slave supports max. 1500 byte I/O data.
- Synchronizes the address areas with the Siemens SIMATIC Manager.
- Saves the configuration in the Siemens SIMATIC Manager project.

The SPEED7 EtherCAT Manager has the following functions:
- Automatic configuration of a slave system
- Manual configuration of a slave system
- Diagnosis of a slave system

Starting the SPEED7 EtherCAT Manager
The SPEED7 EtherCAT Manager can be started from the hardware configurator with ‘Start Device-Tool’ of the context menu of the inserted virtual PROFINET slave.

Exit the SPEED7 EtherCAT Manager
By closing the SPEED7 EtherCAT Manager with ‘File ➔ Exit’ the SPEED7 EtherCAT Manager is closed and the configuration is stored in the Siemens SIMATIC Manager. Here SDBs starting from SDB4000 are created and stored in the system data "tray".

Please consider that these SDBs can only be transferred by the Siemens SIMATIC Manager and not by the hardware configurator!
Work environment of the SPEED7 EtherCAT Manager

The work environment of the SPEED7 EtherCAT Manager is divided into the following parts:

1. Main menu: Here the main functions of the SPEED7 EtherCAT Manager may be accessed.
2. Toolbar: Here you can switch between **Configuration mode** and **Diagnosis mode**.
3. Project Explorer: Here master and slave stations of your system are listed.
4. Device editor: Property dialog of a device (parameter) respectively information area.
5. Selection of the view: In the "Classic View" all the subordinate slave stations are shown indented to the slave stations. In the "Flat view" all the subordinate slave stations are shown at the same level as the slave stations.
6. Here you can find the device information of the component, which is selected in the Project Explorer.
7. In this section you can find the number of networks and slave stations.
8. Here all the messages are listed. Via 'Settings ➔ message level' you can select the type of messages to be shown.
9. Status area: With an online connection the 2 LEDs flash alternately in the Status area. At **Mode** you will find the mode (Diagnosis/Configuration).

**'Expert' mode**

By activating 'View ➔ Expert' you can switch to the **'Expert mode'**. When enabled, the properties dialogues are extended accordingly. In **'Expert mode'** you will have the full scope of the SPEED7 EtherCAT Manager.

**Input field - number format**

Some input fields have the buttons [Dec] respectively [Hex]. By selecting the appropriate button you can set the input format **decimal** respectively **hexadecimal** for the input field.
3.1.1 Main menu

‘Expert’ mode

By activating ‘View ➔ Expert’ you can switch to the ‘Expert mode’. When enabled, the properties dialogs and the Main menu are extended accordingly. In ‘Expert mode’ you will have the full scope of the SPEED7 EtherCAT Manager.

File

- Open / Save / Save As:
  - Open: A different EtherCAT configuration can be loaded than the current configuration in the Siemens SIMATIC Manager project.
  - Save: Save the current EtherCAT configuration in your Siemens SIMATIC Manager project. There are no SDBs created!
  - Save as: Here the EtherCAT configuration is saved in a new project (e.g. Project template).
- ESI manager
  - Here ESI files may be added respectively exported.
- Exit
  - The SPEED7 EtherCAT Manager is closed and the configuration is stored in the Siemens SIMATIC Manager project. Here SDBs starting from SDB4000 are created and stored in the system data “tray”.

View

- Messages
  - Here the display area ‘Messages’ can be enabled respectively disabled in the work environment.
- Information
  - Here the display area ‘Short Info’ can be enabled respectively disabled in the work environment.
- Expert mode
  - Here the expert mode can be enabled respectively disabled. When enabled, the properties dialogs and the Main menu are extended accordingly. In ‘Expert mode’ you will have the full scope of the SPEED7 EtherCAT Manager.
- Refresh
  - Here you can refresh the content of the work environment.

Network

- Scan EtherCAT network
  - Here you can search your connected EtherCAT network for slave stations.
- Edit Topology
  - Here a dialog is opened to change the current topology of your project.
- Export ENI file / Import slaves ENI file
  - Here you can create an ENI file or import a slave station from an ENI file.
- Network mismatch analyser
  - This function may only be called in the “Diagnosis mode”. Here you can compare your configured slave stations to the connected slave stations. Different elements are represented with red font.
- Line Crossed Analyzer (active only after scan)
  - Here wrong connected slave stations can be shown.
- Clear error counters
  - Here all the listed error are deleted.
## Settings

- **Message level**
  Here you can choose, which messages should be displayed in the message area:
  - All Messages
  - Info&warnings&errors
  - Warnings&errors
  - Errors

- **Project template**
  - Select a configuration file as the project template from which the preconfigured slave stations are to be loaded.

  **Settings:**
  - Activate
  - Ignore revision

## Help

- **Show user manual**
  - Opens this user manual.

- **About ...**
  - Among others you get information about the version of the *SPEED7 EtherCAT Manager*. 
3.2 ESI Manager

ESI files are device description files in XML format for the respective slave stations and the peripheral modules. By including an ESI file the SPEED7 EtherCAT Manager gets all the information, which are required for the configuration. During the installation of the SPEED7 EtherCAT Manager the ESI files of the VIPA systems are pre-installed. When installing an ESI file an existing ESI file is saved and the path to the saved file appears. If an ESI file contains a slave more than once (identical revision, product and vendor ID), the slave first found is always used.

Via ‘File ➜ ESI Manager’ the dialog window ‘ESI Manager’ opens. Here you have the following possibilities:

- **Add File**
  - Here you can install an ESI file in the SPEED7 EtherCAT Manager.

- **Add Folder**
  - If you want to add more than one ESI file, you can collect them in a folder. By specifying the folder path all ESI files are installed from this folder in the SPEED7 EtherCAT Manager.

- **Delete**
  - Here you can delete a XML file in the SPEED7 EtherCAT Manager.

- **Export**
  - You can externally save a XML file outside of the SPEED7 EtherCAT Manager. With [Export] you can backup your ESI file before it is deleted and install it again with [Add File].

- **Close**
  - With [Close] the ‘ESI Manager’ is closed.

To reload the ESI data in your project select your slave station and execute ‘Context menu ➜ Reload ESI data’. 
### 3.3 Automatic configuration of a slave system

**Precondition**

The automatic configuration assumes that your EtherCAT system is mounted and can be reached on-line.

There are the following possibilities for on-line connection:

- **Slaves connected to the local system**
  - You are directly connected to a slave station via EtherCAT by means of a separate network adapter. Here the on-line connection is established by specifying the **Network Adapter**.

- **Slaves connected to remote system**
  - You are connected to the Ethernet PG/OP channel of your CPU and can use this to access the EtherCAT master. The on-line connection is established by specifying **IP Address**, **Port** and **Master Instance**. With VIPA **Port 6000** and **Master Instance 0** is to be set.

**Proceeding**

1. Open if not already done the **SPEED7 EtherCAT Manager**
2. Click in the ‘**Project Explorer**’ at ‘**EC-Mastersystem**’
3. Set depending on the on-line access in the ‘**Device Editor > Master**’ as follows:
   - If you are directly locally connected to a slave station via EtherCAT by means of a separate network adapter, select your **Network adapter** and click at [Select].
   - If you are connected to the Ethernet PG/OP channel of your CPU, please enter **IP Address**, **Port** and **Master Instance** and click at [Select]. With VIPA set **Port to 6000** and **Master Instance to 0**.

   When called from the Siemens SIMATIC Manager the IP address is taken once from your project. If you change the IP address you need to adjust this in the Siemens SIMATIC Manager and in the SPEED7 EtherCAT Manager.

4. Click in the ‘**Project Explorer**’ at ‘**EC-Mastersystem**’ and select from the context menu ‘**Scan EtherCAT network**’

   You might be asked if you want to delete the existing slaves. Confirm with [Yes].

   Then the master is listed with its slaves and the associated PDO configuration in the ‘**Project Explorer**’, which was found by the network scan. The system can now be configured accordingly.

If there is no connection possible with the local master, the an anti virus software could block the connection. Then disabling the packet filter of the protocols of the network card in the anti virus software could help.
3.4 Manual configuration of a slave system

Precondition

With the manual configuration the system need not be built and connected online. The system can freely be configured in the SPEED7 EtherCAT Manager.

Proceeding

1. Open if not already done the SPEED7 EtherCAT Manager.
2. Click at the ‘Project Explorer’ at ‘EC-Mastersystem’ and select ‘Context menu ➔ Append Slave(s)’.
   → A dialog opens to insert slave systems
3. Select the according slave from the list, enter the number of slaves and confirm with [OK].
   → The corresponding slave systems are inserted and can be configured now.

3.5 Configuration - EC-Mastersystem

3.5.1 Preparation

Click in the Toolbar at [Configuration] and select ‘EC-Mastersystem’ in the ‘Project Explorer’. As soon you have configured at least one slave station, the following registers are available:

- Chap. 3.5.2 ‘Master’ page 16
- Chap. 3.5.3 ‘Process Data Image’ page 17
- Chap. 3.5.4 ‘Advanced Options (Expert mode)’ page 17
- Chap. 3.5.5 ‘Distributed Clocks (Expert mode)’ page 20
- Chap. 3.5.6 ‘I/O Address Overview’ page 21
3.5.2 Master

Here you can perform master and bus-specific settings.

- **General**
  - **Unit Name**: Name of the master
  - **Cyclic time [µs]**: Interval in µs, in which the process data are read and written (PDO cycle time). Here you can choose between different values.

- **Slaves connected to local system**
  - You are directly connected to a slave station via EtherCAT by means of a separate network adapter. Here the on-line connection is established by specifying the **Network Adapter**.

- **Slaves connected to remote system**
  - You are connected to the PG/OP channel of your CPU and can use this to access the EtherCAT master. The on-line connection is established by specifying **IP Address**, **Port** and **Master Instance**.
    - **IP Address**: Enter the IP Address of the PG/OP channel of the remote CPU.
    - **Port**: Port, over which the communication takes place with the remote CPU. With VIPA use Port 6000.
    - **Master-Instance**: Serves for the master instance of the remote system. With VIPA the master instance is 0.

With [Select] the SPEED7 EtherCAT Manager uses the set connection for communication. By clicking on [Deselect] you can change the connection parameters.

When called from the Siemens SIMATIC Manager the IP address is taken once from your project. If you change the IP address you need to adjust this in the Siemens SIMATIC Manager and in the SPEED7 EtherCAT Manager.
3.5.3 Process Data Image

Here you have a list of S7 respectively EtherCAT addresses, which are used by the modules of all the slave stations. The ‘S7 address’ corresponds to the address in the address area of the CPU. By entering a new ‘Start Address’ you can adjust the S7 addressing of the input and output areas of the modules accordingly.

Information about the assignment of the in/output area can be found in the manual of your module.

The ‘I/O Addresses EtherCAT’ are only visible in ‘Expert mode’! ‘I/O Addresses EtherCAT’ are the offset addresses, which are used within the EtherCAT process image. You cannot change the address. You can use the addresses e.g. for EtherCAT network analysis.

3.5.4 Advanced Options (Expert mode)
This dialog is only visible in the ‘Expert mode’! In this dialog the parameters of the master system can be adjusted and the default settings for all the slave stations can be defined.

**Master Settings**
- Init Command Retries: Number of retries, beyond which a transmission error is returned. (default: 3)
- MasterStateChangeTimeout: Here you can define a timeout for the state change of the master and its slave stations (default: 60000ms). If the MasterStateChangeTimeout is too short, the EtherCAT master reports the error message 0xED21.

**Slave Settings**
- In this area default parameters can be applied for all the slave stations. The settings are applied for all slave stations as default setting by clicking on [Apply changes (to all slaves)]. By selecting the slave station in the ‘Project Explorer’ you always have the possibility to customize the slave parameters via the register ‘Advanced Options’.

### Slave Settings

**Start-up checking:**
Here you can define the items, the EtherCAT master has to check during the transition ‘Init\rightarrow Pre-Op’ (Vendor ID, Product code, Revision number).
- Revision number can be verified:
  "==" → High word is equal, Low word is equal
  ">=" → High word is equal or greater, Low word is equal or greater
  "LW ==" → Low word is equal
  "LW ==, HW >=" → Low word is equal, High word is equal or greater
  "HW ==" → High word is equal
  "HW ==, LW >=" → High word is equal, Low word is equal or greater

**Identification checking:**
- With these parameters, you determine via which HotConnect address the EtherCAT master should identify the slave station.
- ‘Check identification’: When activated, the text box below shows the current HotConnect address, which the EtherCAT master has to use to identify the slave station.
- For identification via the address set on the address switch of the slave station (Explicit Device ID), you have to activate ‘Check identification’ and enter the corresponding ESC register address for addressing via the address switch at ‘Select local address’.
- For identification via SSI (Configured Station Alias) you have to activate ‘Check identification’ and enter the corresponding ESC register address for SSI activation at ‘Select local address’. In this case, the Configured Station Alias address must be specified via ‘EEPROM’ of the slave station in diagnostics mode. In addition, you must specify the Configured Station Alias address in your configuration in ‘Group’ by means ‘Identification value’.

For more information about the ESC register addresses, refer to the manual for your slave station.
Process Data Mode:
Here you specify the command that should be used for process data access.
- ‘LRW activate’: With one Logical-Read-Logical-Write command inputs are read and also outputs are set. This needs 1 frame.
- ‘LRW deactivate’: ‘LRD/LWR:’ Read access with Logical-Read command to inputs and write access with Logical-Write command to outputs. This needs 2 frames.

Overwrite Watchdog:
Writes the configured value in the relevant register of the slave station. Here among others you can set the time of the ‘SM Watchdog’ (SyncManager-Watchdog).
- ‘Set Multiplier’: Writes the configured value to the corresponding slave register: 0x0400
- ‘Set PDI Watchdog’: Writes the configured value to the corresponding slave register: 0x0410
- ‘Set SM Watchdog’: Writes the configured value to the corresponding slave register: 0x0420

Please note that even if a watchdog is present, this need not be indicated in the ESI file and this is shown as inactive!

Timeouts:
- ‘SDO Access’: Internal master timeout for SDO access
- ‘Init → Pre-Op’: Internal master timeout for slave state change from Init to Pre-Op
- ‘Back to Pre-Op, Init’: Internal master timeout for slave state change to Pre-Op and Init

Mailbox Mode:
The ‘Mailbox’ is an a-cyclic communication channel. Here mostly ‘Emergencies’ messages and ‘SDOs’ are buffered. The way of accessing the just unread mailbox data can be specified here.
- ‘Cyclic’: Interval in ms within which the mailbox is to be read (polling mode). If you want short interrupt response times, you should select the mode ‘Cyclic’ and set a short time e.g. 1ms.
- ‘State change’: The mailbox is read only on a state bit change.

Overwrite Mailbox Size
- ‘Output Size’: Overwrites mailbox output size
- ‘Input Size’: Overwrites mailbox input size

When changing the ‘Process Data Mode’ you have to refresh the addresses in the Register ‘Process Image’.
If the Process Data Mode ‘LRW’ is used, the input and the output address of the EtherCAT process image must be identical. Here address leaks can occur between slave stations. If an EtherCAT address exceeds the maximum address area of the CPU, the current configuration gets invalid. You need to reduce the configuration or change to process data mode ‘LRD/LWR’.
If you use long cycle times (> 100ms) you should always accordingly raise the ‘SM Watchdog’. Otherwise your slave station changes after laps of ‘SM Watchdog’ time to Safe-Op and releases OB 86. From now on you can only manually set the slave to Op!
3.5.5 Distributed Clocks (Expert mode)

Due to the hardware, with local connections the function 'distributed clocks' is not supported.

This dialog is only visible in the 'Expert mode'! Here you can adjust the clock functionality accordingly. In EtherCAT "Distributed Clocks" means a logical combination of "clocks", which are located in the EtherCAT devices. With this there is the possibility to locally provide a synchronized time in each bus device. If an EtherCAT device supports the Distributed Clocks functionality, it has its own clock. After PowerON this first locally works, based on an own pulse generator. By selecting an EtherCAT slave station, which has to provide the reference time, the distributed clocks can be synchronized. This reference clock so represents the system time.

- **Reference clock**: Here you get information about the clock, which provides the reference time.
  - **Name**: Name of the reference clock. Per default this is always the 1. slave station, which supports the "Distributed Clock (DC)" functionality.

- **Clock adjustment**
  - **Master Shift**: The EtherCAT master time is synchronized by the reference clock.
  - **Bus Shift**: The reference clock is synchronized by the EtherCAT master time.
  - **External Mode**: The reference clock is controlled by an external master
Options

- Continuous Propagation Compensation: A command (datagram) will be inserted in the cyclic frame which allows the EtherCAT master to measure and compensate the propagation delay time by time.
- Sync Window Monitoring: A command (datagram) will be inserted in the cyclic frame to read the ESC registers 0x092C. If this is selected the master will throw a notification about the state (sync respectively out-of-sync) of your system.
- 64bit system time: Master supports slaves with 32bit and 64bit system time register (0x0910). If this is selected he will interpret it as 64bit system time.

Slaves with active DC

- Shows a list of all slave stations with active DC

3.5.6 I/O Address Overview

Here you have a list of addresses that are used by the I/O components of all the modules in the address area of the CPU. By entering a new ‘Start address’ you can adjust the addressing of the input and output areas accordingly. You can edit ‘Name’ and ‘Comment’ by clicking at the corresponding entry.

With [Export] there is the possibility to save them to a SEQ file. The file can be imported as a symbol file into your project in the Siemens SIMATIC Manager.

Information about the assignment of the in/output area can be found in the manual of your module.
3.6 Configuration - slave station

3.6.1 Preparation

Click in the Toolbar at [Configuration] and select the Slave-Station ‘Slave_...’ in the ‘Project Explorer’. The following registers are available now:

- Chap. 3.6.2 ‘General’ page 23
- Chap. 3.6.3 ‘Modules’ page 24
- Chap. 3.6.4 ‘PDO Mapping’ page 25

Group - if a group exists for this slave station

- Chap. 3.10 ‘Grouping logic’ page 47
- Chap. 3.6.5 ‘Advanced Options (Expert mode)’ page 28
- Chap. 3.6.6 ‘Ethernet (EoE)’ page 31
- Chap. 3.6.7 ‘Distributed Clocks (Expert mode)’ page 32 - if supported
- Chap. 3.6.8 ‘Init Commands (Expert mode)’ page 33
- Chap. 3.6.9 ‘CoE Object Dictionary (Expert mode)’ page 35
- Chap. 3.6.10 ‘Process Image’ page 36
- Chap. 3.6.11 ‘I/O Address Overview’ page 36
3.6.2 General

Here you can perform slave-specific settings such as assignment of name and address to a station. It is also possible to change the connection to the station.

- **Address**
  - Station Address: EtherCAT address of the slave station.

- **Information**
  - Name: Name of the slave station can be assigned accordingly.
  - Description: Description of the slave station.
  - Vendor: Name of the vendor.
  - Product Code: Internal product code of the slave station.
  - Revision Number: Internal revision number of the slave station.
  - ESI File: Path and name of the device file, in which the data of the slave station is stored.
  - Identification Value: Identification Value of the slave station

- **Ports**
  - Connected Devices: List of connected slave stations.
  - Predecessor Device: Name of the predecessor device.
  
  If topology should be changed, please use the ‘Edit Topology’ dialog.
3.6.3 Modules

In this dialog you can assign modules to the appropriate slot.

- **Connect module to slot ("<<")**
  Select your module from the list on the right and add it to a selected slot ‘Terminals’ in the left list by clicking [<<]. This takes place according to the following rules:
  - If no modules are configured, the module is connected to the highlighted slot.
  - Each additional module is inserted below.
  - If modules are already exist, the module is added to the highlighted slot and the following modules are moved accordingly.

- **Disconnect module from slot ("X")**
  - Select from the left list the appropriate slot, which you want to disconnect from the module again and click at ["X"].

There is also the possibility to add or remove modules via the context menu of the ‘Project Explorer’.

- **Option field - ‘Download slot configuration’**
  When enabled, an Init Command is created, which contains the slot configuration with the unique module identifier. During start-up of the slave station the slot configuration serves for comparison between configured and inserted modules. This can prevent misconfigurations.

- **‘Load modules’**
  With this function you can load the configuration from the EtherCAT master for the selected slave station.
3.6.4 PDO Mapping
3.6.4.1 Description

This dialog shows a list of the assigned PDOs. With some slave stations it is possible to activate respectively de-activate certain PDO configurations.

- **Select the Inputs**
  - If your slave station supports it, you can hide the corresponding input PDO from the configuration by disabling the checkbox.

- **Select the Outputs**
  - If your slave station supports it, you can hide the corresponding output PDO from the configuration by disabling the checkbox.

- **Only ‘Expert mode’**
  - **Add / Delete / Edit:**
    Used for changing the lists, if it is allowed by the ESI. First the list, which you want changed, must be selected.
  - **Up / Down:**
    Moving the selected PDO in the selected list up or down.
  - **Load PDO information:**
    Here you can load PDO information directly from the slave station.
PDOs can only be edited in the ‘Expert mode’! Otherwise, the functions are hidden. With [Edit] the dialog ‘Edit PDO’ opens.

- **General**
  - Name: Name of the PDO
  - Index: Index of the PDO (can be entered in hexadecimal or decimal)

- **Flags**
  - Mandatory: If activated the PDO cannot be deleted.
  - Fixed Content: If activated the content of the PDO is write protected. To create new or to edit existing PDOs you have to disable ‘Fixed Content’.
  - Virtual PDO: If activated the PDO has no entries.

- **Direction**
  - TxPDO: Send PDO of the slave station for input data.
  - RxPDO: Receive PDO of the slave station for output data.

- **Sync Manager**
  - Selected the sync manager, which should be used. The selection is only visible if more than one sync manager can be used.

- **Optional**
  - Exclude: Select the PDOs which cannot be activated if this PDO is activated.

- **Entries**
  - Here is the list of configured PDO entries shown.
3.6.4.3 Add PDO (Expert mode)

Via the following dialog the user add a PDO entry.

- **General**
  - Name: Name of the PDO entry
  - Comment: Comment of the PDO entry
  - Swapping: Swapping mode of the PDO entry

- **Settings**
  - Index: Index of the PDO entry (can be entered in hexadecimal or decimal)
  - Subindex: Subindex of the PDO entry (hexadecimal)
  - Datatype: List of available datatypes
  - Bit Length: Length of the PDO entry in bits

- CoE Object-Dictionary (loaded only if Object-Dictionary is supported by slave)

3.6.4.4 Edit PDO (Expert mode)

Via the following dialog the user adit a PDO entry.

- **General**
  - Name: Name of the PDO entry
  - Comment: Comment of the PDO entry
  - Swapping: Swapping mode of the PDO entry
3.6.5 Advanced Options (Expert mode)

This dialog is only visible in the ‘Expert mode’! Here you can make further adjustments to the slave station.

Slave Settings

- **Start-up checking:**
  Here you can define the items, the EtherCAT master has to check during the transition ‘Init→Pre-Op’ (Vendor ID, Product code, Revision number).
  - Revision number can be verified:
    - "==" → High word is equal, Low word is equal
    - "=>" → High word is equal or greater, Low word is equal or greater
    - "LW ==, HW >=" → Low word is equal, High word is equal or greater
    - "HW ==, LW >=" → High word is equal, Low word is equal or greater

- **Identification checking:**
  - With these parameters, you determine via which HotConnect address the EtherCAT master should identify the slave station.
  - ‘Check identification’: When activated, the text box below shows the current HotConnect address, which the EtherCAT master has to use to identify the slave station.
  - For identification via the address set on the address switch of the slave station (Explicit Device ID), you have to activate ‘Check identification’ and enter the corresponding ESC register address for addressing via the address switch at ‘Select local address’.
  - For identification via SSI (Configured Station Alias) you have to activate ‘Check identification’ and enter the corresponding ESC register address for SSI activation at ‘Select local address’.
  - For identification via SSI (Configured Station Alias) you have to activate ‘Check identification’ and enter the corresponding ESC register address for SSI activation at ‘Select local address’. In this case, the Configured Station Alias address must be specified via ‘EEPROM’ of the slave station in diagnostics mode. In addition, you must specify the Configured Station Alias address in your configuration in ‘Group’ by means of ‘Identification value’.

Chap. 3.9.4 ‘EEPROM (Expert mode)’ page 44
Chap. 3.10.3 ‘Create Hot Connect group’ page 50
For more information about the ESC register addresses, refer to the manual for your slave station.

**Process Data Mode:**
Here you specify the command that should be used for process data access.
- **‘LRW activate’**: With one Logical-Read-Logical-Write command inputs are read and also outputs are set. This needs 1 frame.
- **‘LRW deactivate’**/ **‘LRD/LWR’**: Read access with Logical-Read command to inputs and write access with Logical-Write command to outputs. This needs 2 frames.

**Overwrite Watchdog:**
Writes the configured value in the relevant register of the slave station. Here among others you can set the time of the **‘SM Watchdog’** (SyncManager-Watchdog).
- **‘Set Multiplier’**: Writes the configured value to the corresponding slave register: 0x0400
- **‘Set PDI Watchdog’**: Writes the configured value to the corresponding slave register: 0x0410
- **‘Set SM Watchdog’**: Writes the configured value to the corresponding slave register: 0x0420

Please note that even if a watchdog is present, this need not be indicated in the ESI file and this is shown as inactive!

**Timeouts:**
- **‘SDO Access’**: Internal master timeout for SDO access
- **‘Init à Pre-Op’**: Internal master timeout for slave state change from Init to Pre-Op
- **‘Back to Pre-Op, Init’**: Internal master timeout for slave state change to Pre-Op and Init
- **‘Op à Safe-Op’**: Internal master timeout for slave state change from Op to Safe-Op

Please refer to Chap. 3.11 ‘EtherCAT State Machine’ page 52

**Mailbox Mode:**
The **‘Mailbox’** is an a-cyclic communication channel. Here mostly **‘Emergencies’** messages and **‘SDOs’** are buffered. The way of accessing the justunread mailbox data can be specified here.
- **‘Cyclic’**: Interval in ms within which the mailbox is to be read (polling mode). If you want short interrupt response times, you should select the mode **‘Cyclic’** and set a short time e.g. 1ms.
- **‘State change’**: The mailbox is read only on a state bit change.

**Overwrite Mailbox Size**
- **‘Output Size’**: Overwrites mailbox output size
- **‘Input Size’**: Overwrites mailbox input size
When changing the ‘Process Data Mode’ you have to refresh the addresses in the Register ‘Process Image’.

If the Process Data Mode ‘LRW’ is used, the input and the output address of the EtherCAT process image must be identical. Here address leaks can occur between slave stations. If an EtherCAT address exceeds the maximum address area of the CPU, the current configuration gets invalid. You need to reduce the configuration or change to process data mode ‘LRD/LWR’.

If you use long cycle times (> 100ms) you should always accordingly raise the ‘SM Watchdog’. Otherwise your slave station changes after laps of ‘SM Watchdog’ time to Safe-Op and releases OB 86. From now on you can only manually set the slave to Op!

Distributed Clocks: ‘Potential Reference Clock’

Every slave station can be used as a ‘Potential Reference Clock’ if the slave supports the DC registers. The setting is used, when you remove the slave with activated ‘Potential Reference Clock’ e.g. via ‘Hot Connect’, then the master searches for a slave station where ‘Potential Reference Clock’ is activated. If no slave is available, the first DC slave is used.
3.6.6 Ethernet (EoE)

Here you activate or change EoE (Ethernet over EtherCAT) the settings.

- **Ethernet (activates EoE support)**
  - Virtual MAC address: Virtual MAC address. If ‘Auto’ is checked, the Virtual MAC address will be generated from the Station Address, e.g. Station Address is "1010" (= 0x03F2), will generate the Virtual MAC address: "01 00 00 03 F2"
  - Time Stamp Requested: Slave station will response with the exact send time and the same Frame number and he should response as soon as possible.
  - Port Mode: Slave station can be run in ‘Switch Port’ or ‘IP Port’ mode.

- **Override IP Settings**
  - All IP settings will be overwritten from master like IP Address, Subnet Mask, Default Gateway, DNS Server and DNS Name.
3.6.7 Distributed Clocks (Expert mode)

This dialog is only visible in the ‘Expert mode’ if this is supported by your slave station! Here you can adjust the settings for Distributed Clocks accordingly. In EtherCAT "Distributed Clocks" (DC) means a logical combination of "clocks", which are located in the EtherCAT devices. With this there is the possibility to locally provide a synchronized time in each bus device. If an EtherCAT device supports the Distributed Clocks functionality, it has its own clock. After PowerON this first locally works, based on an own pulse generator. By selecting an EtherCAT slave station, which has to provide the reference time, the distributed clocks can be synchronized. This reference clock so represents the system time.

- **Reference clock**
  - Operation Mode: Here you can set the operation mode of the reference clock. More may be found in the manual of your slave station.
  - Sync Unit Cycle: Cycle time of the master. Chap. 3.5 ‘Configuration - EC-Mastersystem’ page 15

- **Sync Units**
  - Sync Unit 0
    - Cycle Time: Here you can specify the cycle time in relation to the ‘Master Cycle’ or ‘User defined’.
    - Time Shift: Specify here a time shift. This is used for fine adjustment.
  - Sync Unit 1
    - Cycle Time: Here you can specify the cycle time in relation to the ‘Master Cycle’, to the cycle of Sync Unit 0 ‘Sync 0 Cycle’ or ‘User defined’.
    - Time Shift: Specify here a time shift. This is used for fine adjustment.

Due to the hardware with a local connection Distributed Clocks (connection via network adapter) is not supported!
### 3.6.8 Init Commands (Expert mode)

#### 3.6.8.1 Description

This dialog is only visible in the ‘Expert mode’!

- For each parameter of a slave station or module, which differs from the standard setting you have to create an Init command!
- If a write access to an object in the configuration mode is performed, and the written value does not reflect to the default value of the object, so this command is automatically added to the ‘Init Commands’.

Here you can see a list of the current configured Init Commands and if it is allowed you can also add/edit/delete the commands.

- **Init Commands**: Init Commands come from the ESI file or are automatically generated on write access to CoE objects or can be created by the user. You either have full-access (RW = Read/Write) or only read access (RO = Read-only). Init commands from ESI files are automatically listed here. These cannot be changed or deleted.
- **Edit Init Commands**
  - New, Copy, Edit, Delete: Used for changing Init Commands.
  - Move Up, Move Down: Moving the selected Init Command up or down.
3.6.8.2 CoE Init Command (Expert mode)

This dialog is only visible in the ‘Expert mode’! With [New] the dialog ‘Add CoE Init Command’ opens. This dialog also opens to edit CoE Init Commands, which just exist.

- **General**
  - Index/Subindex: CoE-Index respectively Subindex of the Init Command
  - Value: Value of the Init Command, which should be written in the chose transition (only available if ‘Direction’ is set to ‘Download’). If type of data is unknown, the hex format must be used. (Example: "0011 2233 …").
  - Comment: Here you can comment your Init Command.

- **Transition**
  - Determines in which transition the Init Command will be executed.

- **Further Settings**
  - Complete Access: Determines if the complete SDO object should be written/read.

- **Direction**
  - Download: Writes value to slave station.
  - Upload: Reads value from slave.

- **CoE Object Dictionary**: Select here the value in the CoE Object Dictionary of the slave station, you want to edit.
3.6.9 CoE Object Dictionary (Expert mode)

This dialog is only visible in the ‘Expert mode’! Here you will have read and write access to the CoE Object Dictionary of the slave station. This can be changed if your slave station permits. It is indicated by the ‘Flags’ of each object, if write access is permitted. Information about the structure of the Object Dictionary can be found in the manual of your slave station.

Description of the flags: "AA BB (CC DD EE)"

- **AA, BB**
  - Rx: Mapping as receive PDO
  - Tx: Mapping as send PDO
  - --: Mapping not allowed

- **CC:**
  - Access rights for state PreOp (RO, WO, RW)

- **DD:**
  - Access rights for state SafeOp (RO, WO, RW)

- **EE:**
  - Access rights for state Op (RO, WO, RW)
  - chap. Ch. 3.11 ‘EtherCAT State Machine’ page 52

- **Edit Value**
  - Write: Changes the selected entry
  - Reset: Resets the selected entry to ESI default

If a write access to an object in the configuration mode is performed, and the written value does not reflect to the default value of the object, so this command is automatically added to the ‘Init Commands’. Chap. 3.6.8 ‘Init Commands (Expert mode)’ page 33
3.6.10 Process Image

Here you have a list of S7 respectively EtherCAT addresses, which are used by the modules of the slave system. The 'S7 address' corresponds to the address in the address area of the CPU. By entering a new 'Start address' you can adjust the S7 addressing of the input and output areas of the modules accordingly. Information about the assignment of the in/output area can be found in the manual of your module.

The 'I/O addresses EtherCAT' are only visible in 'Expert mode'! 'I/O addresses EtherCAT' are the addresses, which are used within the EtherCAT bus. You cannot change the address. You can use the addresses e.g. for EtherCAT network analysis.

3.6.11 I/O Address Overview

Here you have a list of addresses, which are used by the I/O components of the modules of the selected slave system in the address area of the CPU. By entering a new 'Start address' you can adjust the addressing of the input and output areas accordingly. You can edit 'Name' and 'Comment' by clicking at the corresponding entry.

Information about the assignment of the in/output area can be found in the manual of your module.
3.7 Configuration - modules

3.7.1 Please note

With an E-Bus slave the dialog of the module configuration are hidden!
⇒ Chap. 3.10 ‘Grouping logic’ page 47

3.7.2 Preparation

Select in the configuration mode in the ‘Project Explorer’ the module of the according slave station. The following registers are available now:
⇒ Chap. 3.7.3 ‘MDP Slot Properties’ page 37
⇒ Chap. 3.7.4 ‘Process Image’ page 38
⇒ Chap. 3.7.5 ‘I/O Address Overview’ page 38

3.7.3 MDP Slot Properties

Here you can see the MDP Slot Properties of the corresponding module. This dialog serves for information. You cannot change something.

- **General**
  - **Vendor**: Name of the vendor of the module.
  - **ESI file**: Path and name of the device file, in which the data of the module and the associated slave station is stored.

- **Slot**
  - **Name**: Name of the slot
  - **Number**: Number of the slot

- **Module**
  - **Name**: Name of the module
  - **Type**: Order number of the module
  - **Class**: Module class
  - **Identificator**: Identification number of the according module class.

![Project Explorer](Image)
3.7.4 Process Image

Here you have a list of S7 respectively EtherCAT addresses, which are used by the modules of all the slave stations. The ‘S7 address’ corresponds to the address in the address area of the CPU. By entering a new ‘Start Address’ you can adjust the S7 addressing of the input and output areas of the modules accordingly.

Information about the assignment of the input/output area can be found in the manual of your module.

The ‘I/O Addresses EtherCAT’ are only visible in ‘Expert mode’! ‘I/O Addresses EtherCAT’ are the addresses, which are used within the EtherCAT bus. You cannot change the addresses. You can use the addresses e.g. for EtherCAT network analysis.

3.7.5 I/O Address Overview

Here you have a list of addresses that are used by the module in the address area of the CPU. By entering a new ‘Start address’ you can adjust the addressing of the input and output areas accordingly. You can edit ‘Name’ and ‘Comment’ by clicking at the corresponding entry.

With [Export] there is the possibility to save them to a SEQ file. The file can be imported as a symbol file into your project in the Siemens SIMATIC Manager.

Information about the assignment of the input/output area can be found in the manual of your module.
### 3.8 Diagnostics - EC-Mastersystem

#### 3.8.1 Preparation

To use the ‘Diagnostics’ functions, you must be connected online with your EtherCAT system.

1. Click in the Toolbar at [Configuration] and select ‘EC-Mastersystem’ in the ‘Project Explorer’.
2. Activate in the ‘Device editor’ the register ‘Master’.
3. Set depending on the on-line access in the ‘Device Editor > Master’ as follows:
   - If you are directly connected to a slave station via EtherCAT by means of a separate network adapter, select your Network Adapter and click at [Select].
   - If you are connected to the PG/OP channel of your CPU, please enter IP Address, Port and Master Instance and click at [Select]. With VIPA Port 6000 and Master Instance 0 is to be set.
   - The SPEED7 EtherCAT Manager uses the set connection for communication. By clicking on [Deselect] you can change the connection parameters.
4. Click in the Toolbar at [Diagnosis Mode].
   - An online connection to your EtherCAT system is established via the preset communication channel and the current project configuration in the ‘Project Explorer’.
   - With an online connection the 2 LEDs flash alternately in the ‘Status area’. In addition ‘Modus’ switches to ‘Diagnosis’.
5. Click in the ‘Project Explorer’ at Master.
   - The following registers are available now:
     - Chap. 3.8.2 ‘General’ page 39
     - Chap. 3.8.3 ‘CoE Object Dictionary’ page 41
     - Chap. 3.8.4 ‘History (Expert mode)’ page 41

### 3.8.2 General

**State Machine**

<table>
<thead>
<tr>
<th>Current State</th>
<th>Requested State</th>
<th>Change State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Op</td>
<td>Op</td>
<td>Pre-Op</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Safe-Op</td>
</tr>
<tr>
<td></td>
<td></td>
<td>Op</td>
</tr>
</tbody>
</table>

**Information**

<table>
<thead>
<tr>
<th>Number of found slaves</th>
<th>2</th>
</tr>
</thead>
<tbody>
<tr>
<td>Number of slaves in configuration</td>
<td>2</td>
</tr>
<tr>
<td>Number of DC slaves</td>
<td>0</td>
</tr>
<tr>
<td>DC in-sync</td>
<td>-</td>
</tr>
<tr>
<td>Topology Ok</td>
<td>Yes</td>
</tr>
<tr>
<td>Link Connected</td>
<td>Yes</td>
</tr>
<tr>
<td>Slaves in Master State</td>
<td>Yes</td>
</tr>
<tr>
<td>Frame Counter</td>
<td></td>
</tr>
<tr>
<td>Sent frames</td>
<td>20388</td>
</tr>
<tr>
<td>Lost frames</td>
<td>0</td>
</tr>
<tr>
<td>Cyclic frames</td>
<td>20385</td>
</tr>
<tr>
<td>Acyclic frames</td>
<td>82</td>
</tr>
</tbody>
</table>

**Colors and states**

The state of the state machine can be determined via the color according to the following specifications:
Here you will get master and bus-specific information.

### State Machine
- **Current State**: Shows the current state of master. 
  - Chap. 3.11 ‘EtherCAT State Machine’ page 52
- **Requested State**: Shows the currently requested state of the master which was requested by ‘Change State’.
- **Change State**: Here you can change the state of the master.

### Information
- **Number of found slaves**: Shows number of found slave stations at the bus.
- **Number of slaves in configuration**: Shows number of configured slave stations at the bus.
- **Number of DC slaves**: Shows the number of slave stations, which support distributed clocks functionality (DC).
- **DC in-sync**: If distributed clocks is configured you can find here information about the synchronization status of the system.
- **Topology OK**: The ‘Topology’ is OK (‘Yes’), if the number of configured matches the number of found slave stations. Here only the mandatory slaves stations are considered.
- **Link Connected**: Here you will find ‘Yes’, if there is a physical connection to the configured slave stations.
- **Slaves in Master State**: Here you will find ‘Yes’, if every configured slave station is in master state.

### Frame Counter
- **Sent frames**: Number of sent frames since the last power cycle.
- **Lost frames**: Number of lost frames since the last power cycle.
- **Cyclic frames**: Number of cyclic frames since the last power cycle.
- **Acyclic frames**: Number of acyclic frames since the last power cycle.
3.8.3 CoE Object Dictionary

Here you will have read and write access to the CoE Object Dictionary of the slave station. This can be changed if your slave station permits. It is indicated by the ‘Flags’ of each object, if write access is permitted. Information about the structure of the Object Dictionary can be found in the manual of your slave station.

3.8.4 History (Expert mode)

In this dialog box, you can access all the diagnostic messages in the master and edit them if necessary. Via ‘Settings’ they may be filtered accordingly.
3.9 Diagnostics - slave station

3.9.1 Preparation

To use the ‘Diagnostics’ functions, you must be connected online with your EtherCAT system.

1. Click in the Toolbar at [Configuration] and select ‘EC-Mastersystem’ in the ‘Project Explorer’.
2. Activate in the ‘Device editor’ the register ‘Master’.
3. Set depending on the on-line access in the ‘Device Editor > Master’ as follows:
   - If you are directly connected to a slave station via EtherCAT by means of a separate network adapter, select your Network Adapter and click at [Select].
   - If you are connected to the PG/OP channel of your CPU, please enter IP Address, Port and Master Instance and click at [Select]. With VIPA Port 6000 and Master Instance 0 is to be set.
   ⇒ The SPEED7 EtherCAT Manager uses the set connection for communication. By clicking on [Deselect] you can change the connection parameters.
4. Click in the Toolbar at [Diagnosis Mode].
   ⇒ An online connection to your EtherCAT system is established via the preset communication channel and the current project configuration in the ‘Project Explorer’.
   With an online connection the 2 LEDs flash alternately in the ‘Status area’. In addition ‘Modus’ switches to ‘Diagnosis’.
5. Click in the ‘Project Explorer’ at the according slave station ‘Slave_...’

The following registers are available now:
   - Chap. 3.9.2 ‘General’ page 42
   - Chap. 3.9.3 ‘ESC Register (Expert mode)’ page 43
   - Chap. 3.9.4 ‘EEPROM (Expert mode)’ page 44
   - Chap. 3.9.5 ‘Extended Diagnosis (Expert mode)’ page 44
   - Chap. 3.9.6 ‘DC Diagnosis (Expert mode)’ page 45
   - Chap. 3.9.7 ‘CoE Object Dictionary’ page 45

3.9.2 General

### Colors and states

The state of the state machine can be determined via the color according to the following specifications:
### Color

<table>
<thead>
<tr>
<th>Color</th>
<th>State of the state machine</th>
</tr>
</thead>
<tbody>
<tr>
<td>- red</td>
<td>Init / Bootstrap</td>
</tr>
<tr>
<td>- blue</td>
<td>Pre-Op</td>
</tr>
<tr>
<td>- yellow</td>
<td>Safe-Op</td>
</tr>
<tr>
<td>- green</td>
<td>Op</td>
</tr>
</tbody>
</table>

- **State Machine**
  - Current State: Shows the current state of the state machine of the slave station.
  
  *Chap. 3.11 ‘EtherCAT State Machine’ page 52*
  
  - Requested State: Shows the requested state of the slave station.
  
  - Change State: Here you can change the state of the state machine of the slave station.

- **Error State**
  - Current: Slave error which occurred during state transition.

### 3.9.3 ESC Register (Expert mode)

This dialog is only visible in the ‘Expert mode’! Here you can directly access the registers of the EtherCAT ASIC. You should not make any changes here!
3.9.4 EEPROM (Expert mode)

This dialog is only visible in the 'Expert mode'! Here you can access the contents of the EEPROM of the slave station. Currently you can only change the parameter 'Configured Station Alias'. This can be used for forming groups. § Chap. 3.10 'Grouping logic' page 47

**CAUTION!**
Please regard that your slave station can get unusable by entering incorrect values especially in 'Hex view'! In this case, any warranty of the vendor is excluded!

3.9.5 Extended Diagnosis (Expert mode)

**This dialog is only visible in the 'Expert mode'!**

### Common Error Counter

- **Processing Unit Error Counter**: 1
- **PDI Error Counter**: 0

#### Port 0 (In port)

- **Invalid Frame Counter**: 0
- **RX Error Counter**: 0
- **Lost Link Counter**: 0
- **Forwarded RX Error Counter**: 0

#### Port 1

- **Invalid Frame Counter**: 0
- **RX Error Counter**: 0
- **Lost Link Counter**: 0
- **Forwarded RX Error Counter**: 0

#### Port 2

- **Invalid Frame Counter**: 0
- **RX Error Counter**: 0
- **Lost Link Counter**: 0
- **Forwarded RX Error Counter**: 0

#### Port 3

- **Invalid Frame Counter**: 0
- **RX Error Counter**: 0
- **Lost Link Counter**: 0
- **Forwarded RX Error Counter**: 0
3.9.6 DC Diagnosis (Expert mode)

This dialog is only visible in the ‘Expert mode’! Here status information for the distributed clock of your slave station is shown. More may be found in the manual of the slave station.

3.9.7 CoE Object Dictionary

Here you will have read and write access to the CoE Object Dictionary of the slave station. This can be changed if your slave station permits. It is indicated by the ‘Flags’ of each object, if write access is permitted. Information about the structure of the Object Dictionary can be found in the manual of your slave station.
If a write access to an object in the diagnosis mode is performed, and the written value does not reflect to the default value of the object, so this command is automatically added to the ‘Init commands’. Chap. 3.6.8 ‘Init Commands (Expert mode)’ page 33

This dialog is only visible in the ‘Expert mode’:

- Designation from ESI
  - By selecting this function the designations are loaded from the ESI file.
- Designation from slave
  - By selecting this function the designations are loaded from the slave station.
- Single Object
  - With this function you have read and write access to a single object in the object dictionary by specifying index and subindex.

3.9.8 FoE Download/Upload

- With this function you have the possibility to transfer files between PC and slave station (if this is supported by the device). If the slave station is in state Bootstrap, a firmware update of the slave station can be established via ‘FoE Download’. Here you have to enter the file name without extension. Chap. 3.12 ‘Firmware update - VIPA System SLIO IM 053-1ECx’ page 53
  - Local filename: Name of the file at the PC.
  - Slave filename: Name of the file at the slave station.
  - Password: Password to access the slave station.
  - Timeout: Maximum time for data transfer.
  - Max. file size: Maximum size of the file, which is to be transferred from the slave station to the PC.
3.10 Grouping logic

3.10.1 Overview

With EtherCAT, the following slave types are distinguished:

**MII slave**
- MII corresponds to Media Independant Interface. An MII slave has an EtherCAT interface to connect to EtherCAT for integration into a system bus (backplane bus) for connecting peripheral modules. The MII slave receives data via EtherCAT and passes them through its backplane to the according peripheral module. Conversely, it reads the input data and passes it via EtherCAT. The System SLIO 053-1EC0x e.g. is a MII-Slave.

**E-Bus slave**
- In an E-Bus slave the EtherCAT protocol is used for communication on the backplane bus. For this reason, the attached peripheral modules are also shown as a slave station in the SPEED7 EtherCAT Manager.

### Possibilities

The EtherCAT Manager supports the following ways to group the individual slave stations. Each group may consist of 1 .. n slave stations. Group nesting is not supported:

- Chap. 3.10.2 'Create group with pinned process data offset' page 49
- 'Hot Connect group with Dynamic Position in Topology' page 51
- 'Hot Connect group with Fixed Position in Topology' page 51
- 'Hot Connect group with Pinned or Dynamic Process Data Offset' page 51

Please consider that Hot Connect groups are not possible with E-Bus slaves!

### Create Group

1. Click in the Toolbar of the SPEED7 EtherCAT Manager at [Configuration].
2. Click in the Project Explorer at the slave station and select 'Context menu – Create Group'.

The dialog ‘Create Group’ opens. Here always the 1. slave station is selected. You can either select more slave stations or depending on the group type selection, the necessary save stations are automatically selected.

With the ‘Create Group’ functionality you have two different functions:

- You can create a new group if the selected slave station is not yet part of a group.
- If the selected slave station is already part of a group, the current group is divided into two sub-groups from the selected slave station.
After creating a group, the ‘Device Editor’ of the slave station is extended with the register ‘Group’. Here you can adjust the group properties accordingly.

The new group can be selected by selecting this group via ‘Cut Slave(s)’ be changed.

If you want to connect this group to an other slave station on the network, you can detach the current connection by ‘Detach HC Group’.

To remove a group click in the SPEED7 EtherCAT Manager at a slave station and select ‘Context menu ➔ Remove Group’.

The group is removed. Depending on the group, the previously grouped slave stations are reintegrated into the topology or remain at the current position.
3.10.2 Create group with pinned process data offset

**Procedure**

This group may start at any slave station and either end at himself, at a following slave station, at a following group or at the last slave station. The group functionality is possible with each slave type. The slave stations of this group are pinned at a fix position in the topology.

**Create Group**

1. Click in the Toolbar of the *SPEED7 EtherCAT Manager* at [Configuration].
2. Click in the *Project Explorer* at the slave station and select ‘Context menu ➔ Create Group’.
   ➔ The dialog ‘Create Group’ opens. Here always the 1. slave station is selected. You can either select more slave stations or depending on the group type selection, the necessary save stations are automatically selected.

**Pinned group**

1. Choose from ‘Select the slaves’ the slave stations, which you want to include in the ‘Pinned group’.
   ➔ The dialog is closed, the slave station is marked as group in the ‘Project Explorer’ and a tab "Group" is created in the ‘Device Editor’.

2. Enable the option ‘Pinned Group’.
3. Enable the option ‘Input Offset = Output Offset’ if the input and output addresses are identical.
   ➔ The group is now defined as Pinned Group.
In a Hot Connect group several slave stations can be located, which must only optional be available at the EtherCAT bus. So you have the possibility to take or add pre-configured sections from the traffic before starting the system or during the operation. This can be done by disconnecting/connecting the communication path or enabling/disabling the participant.

Please consider that the first slave station after the EtherCAT master must not be optional!

To use the hot connect function with E-Bus slave stations, the E-Bus head station and the connected slave stations must be in the same group! % Chap. 3.10 'Grouping logic' page 47

Create Group

1. Click in the Toolbar of the SPEED7 EtherCAT Manager at [Configuration].
2. Click in the Project Explorer at the slave station and select ‘Context menu ➔ Create Group’.
   ⇒ The dialog ‘Create Group’ opens. Here always the 1. slave station is selected. You can either select more slave stations or depending on the group type selection, the necessary save stations are automatically selected.
Hot connect group

1. Choose from ‘Select the slaves’ the slave stations, which you want to include in the ‘Hot connect group’.

   ⇒ The dialog is closed, the slave station is marked as group in the ‘Project Explorer’ and a tab "Group" is created in the ‘Device Editor’.

2. Enable the option ‘Hot connect group’.

3. Enter an ‘Identification value’: This is the Station-Alias-Address, which you have to assign before to the slave station in the ‘Diagnosis’ Mode. % Chap. 3.9.4 ‘EEPROM (Expert mode)’ page 44

   Please regard that the slave station takes the new address after a power-cycle.

4. For a fix position of the group in the topology the option ‘Pinned group’ can be enabled.

3.10.3.2 Combination possibilities

**Hot Connect group with Dynamic Position in Topology**

The group must start with a MII slave. Here, all slave stations below the selected are automatically added to the group. This group ends at himself, at a following slave station, at a following group or at the last slave station.

**Hot Connect group with Fixed Position in Topology**

The group is fix coupled to a predecessor slave station and its port. You always have the possibility to change the link to the previous slave station via the dialog box. If the group is removed, the slave stations remain in place.

*A Hot Connect group with Fixed Position in Topology cannot be removed, if the slave stations before are a part of another Hot Connect group with Fixed Position in Topology!*

**Hot Connect group with Pinned or Dynamic Process Data Offset**

This group does not depend on slave station or port. The group has no predecessor slave station and is moved to the end of the tree when created. When the group is removed it is searched for a suited free port starting from the end of the main tree. If there is no suited slave station available, the group will be rejected! Due to the system the group has no predecessor slave station, the connection cannot be changed via the dialog box.
3.11 EtherCAT State Machine

States

In each EtherCAT communication device a state machine is implemented. For each state there is defined which communication service is active via EtherCAT. The state machine of the slave station is controlled by the state machine of the EtherCAT master.

- **Init - 01h**: After power-on the EtherCAT members are in state *Init*. There is neither mailbox nor process data communication possible. The EtherCAT master initializes the SyncManager channels 0 and 1 for the mailbox communication.

- **Pre-Operational (Pre-Op) - 02h**: The EtherCAT master initializes the SyncManager channels for process data (starting with SyncManager channel 2), the FMMU channels and the PDO mapping respectively the SyncManager PDO assignment. Further in this state the settings for process data transfer and the module-specific parameters, which deviate from the default values are transferred. During the transition from *Init* to *Pre-Op* the EtherCAT slave checks whether the mailbox was correctly initialized. In the state *Pre-Op* mailbox communication and Ethernet over EtherCAT (EoE) are possible but the process data communication is blocked.

- **Safe-Operational (Safe-Op) - 04h**: In *Safe-Op* the input data are cyclically updated but the outputs are de-activated. With the transition from *Pre-Op* to *Safe-Op* the EtherCAT slave checks if the SyncManager channels for process data communication are correct. Before it acknowledges the state change, the EtherCAT slave copies current input data to the corresponding DP RAM areas of the EtherCAT slave controller. In the state *Safe-Op* mailbox and process data communication is possible.

- **Operational (Op) - 08h**: In the state *Op* the input data are cyclically updated and the EtherCAT master sends output data to the EtherCAT slave. The EtherCAT slave copies the output data of the master to its outputs and return input data to the EtherCAT master. In this state process data and mailbox communication is possible.

- **Bootstrap - option (Boot) - 03h**: In state *Boot* the firmware of an EtherCAT slave may be updated via the EtherCAT master. This state may only be reached via *Init*. In the state *Boot* is mailbox communication via the protocol File-Access over EtherCAT (FoE) possible. Other mailbox and process data communications are de-activated.
3.12 Firmware update - VIPA System SLIO IM 053-1EC0x

Current firmware at www.vipa.com

The latest firmware versions are to be found in the service area at www.vipa.com. Load the Px000xxx.pkg file.

CAUTION!

– When installing a new firmware you have to be extremely careful. Under certain circumstances you may destroy the slave station, for example if the voltage supply is interrupted during transfer or if the firmware file is defective. In this case, please call the VIPA Hotline!
– Please regard that the version of the update firmware has to be different from the existing firmware otherwise no update is executed.

Precondition

There is an Ethernet respectively remote connection between the PC and the VIPA EtherCAT slave station, where a firmware update is to be established.

Proceeding

Below the proceeding is shown by the example of the VIPA System SLIO slave station. For other devices, please follow the procedures described in the according manual.

1. Open if not already done the SPEED7 EtherCAT Manager.
2. Click in the ‘Project Explorer’ at ‘EC-Mastersystem’.
3. Select in ‘Device Editor > Master’ at ‘Network Adapter’ your network card and enter at ‘IP Address’ the IP address of the PG/OP channel of the CPU and click at [Select].
4. Click in the Toolbar at [Diagnosis Mode].
   - An online connection to your EtherCAT system is established via the preset communication channel and the current project configuration in the ‘Project explorer’.
5. Click in the ‘Project explorer’ at the master.
6. Select in the register ‘General’ at ‘State Machine’ the state ‘Init’. Wait, until all slave station response the state ‘Init’.
7. Click in the ‘Project explorer’ at the slave, where the firmware update is to be established.
8. Select in the register ‘General’ at ‘State Machine’ the state ‘Bootstrap’.
9. Enter in the register ‘FoE ’ at ‘FoE Download’ as follows:
   - Filename: Px000xxx
   - Password (hex): 0x00000000
   - Timeout (ms): 60000
   - Max File Size (kb): 3000
10. Click at [Download].
   - A dialog for file selection opens.
11. Select the file. The transfer starts with [OK].
   - There will be a progress bar displayed, which informs you about the transfer state.
12. After successful download bring your slave in the ‘Init’ state.
   ⇨ With this operation the firmware file is taken.